May 2014

An Investigation of the Porcine Circovirus Type 1 Third Viral Protein Nuclear Export Capability Through Fluorescence Microscopy and Rapid Prototyping

Aaron Baruch Benjamin  
Worcester Polytechnic Institute

Timothy Jason Beane  
Worcester Polytechnic Institute

Follow this and additional works at: https://digitalcommons.wpi.edu/mqp-all

Repository Citation
An Investigation of the Porcine Circovirus Type 1 Third Viral Protein Nuclear Export Capability Through Fluorescence Microscopy and Rapid Prototyping

A Major Qualifying Project

Submitted to the faculty of

WORCESTER POLYTECHNIC INSTITUTE

in partial fulfillment of the requirements for the Degree of Bachelor of Science in

Biochemistry and Chemistry by:

______________________________________
Timothy Beane

______________________________________
Aaron Benjamin

May 1st, 2014

Approved:

______________________________________
Dr. Destin Heilman, Advisor

Department of Chemistry and Biochemistry, WPI
# Table of Contents

Abstract .................................................................................................................. 2

Acknowledgements ................................................................................................. 3

Introduction ............................................................................................................ 4

Methods and Materials .......................................................................................... 13

Results .................................................................................................................... 19

Discussion .............................................................................................................. 24

Figures and Tables ................................................................................................. 32

References ............................................................................................................. 46

Appendix ................................................................................................................ 51

  Necessary Programs ............................................................................................ 51

  Other Helpful Programs ...................................................................................... 51

  Model Preparation Protocol ................................................................................ 52
Abstract

Porcine Circovirus Type 1 (PCV1) Third Viral Protein (VP3) has anti-cancer properties similar to Apoptin, a well known viral protein that induces apoptosis in cancerous cell. Apoptin is known to be CRM-1 dependent, while PCV1 VP3 only has circumstantial evidence. Another major difference between PCV1 VP3 and Apoptin is that PCV1 VP3 has two nuclear export sequence (NES) regions while Apoptin has only one. The second NES region in the PCV1 VP3 genome is seen in a region known as the “tail” region, a region that codes for an additional 101 amino acids. To test CRM-1 dependence for PCV1 VP3, a competitive CRM-1 NES binding site inhibitor, leptomycin B (LMB), was added to cells transfected with PCV1 VP3 DNA or DNA containing only the tail region. Three-dimensional printing was also experimented with to test induced fit of CRM-1 to NES sites in lieu of traditional computer modeling simulations. The data shows that LMB had a slight effect on the tail region of PCV1 VP3, which leads us to believe that there may be something else responsible for CRM-1 binding besides the tail NES.
Acknowledgements

We would like to thank Erica Stultz for her expertise and work to print our three-dimensional protein models. We would like to thank Scott Sheppard of Autodesk Labs, Autodesk, Inc. for providing crucial software that helped tremendously with the editing of protein structures. We would like to thank Samuel Eisenberg, Lee Hermsdorf-Krasin, and Curtis Innamorati for their research during the summer of 2013 that led to our major qualifying project. We would like to especially thank Mr. Eisenberg for sharing his input and experiences that have helped us along our project. Finally, we would very much like to thank Dr. Destin Heilman for his guidance, patience, and expertise, along with keeping a relaxing, enjoyable work environment. We hope you enjoy your new teaching tools and office paperweights for years to come.
Introduction

An estimated 8.2 million people died from non-melanoma cancers in 2012 (WHO, 2012). Common cancer therapies include powerful drugs and doses of radiation that target fast-dividing cells in a relatively nonspecific manner, targeting cancerous cells and some healthy primary cells, leading to adverse effects such as nausea, hair loss, anemia, and immunosuppression. Targeted cancer therapies are becoming more prevalent in medicine as the specific properties are exploited to trigger immune responses through monoclonal antibodies or suppression of receptors on cancer cells to prevent growth from hormone binding. What does not exist is a generalized yet cancer cell-targeting therapy that leaves healthy primary cells unaffected.

Some small, non-crystallizable, viral proteins have recently been found to have anticancer properties. The proteins arise from several viruses, including Porcine Circovirus Type 1 (Chaiyakul et al., 2010), related to the Porcine Circovirus type 2 that plagues the pork industry (Harding, 2007), Chicken Anemia Virus (Adair, 2000; Schat, 2009), and the asymptomatic Torque Teno Virus (Savic et al., 2010) found to be infected in a majority of the human population. All three are from the loose collection of viruses known as circoviridae, a series of circular, small, non-enveloped, icosahedral, single-stranded DNA viruses that are known to infect mammals and various species of birds. One of the more prominent species of circoviridae is the Porcine Circovirus (PCV) with its two serotypes, type 1 and type 2. Porcine circovirus was first characterized in 1974 by Tischer et al. as a permanent, picornavirus-like contaminant of the pig kidney cell line PK/15 and was characterized eight years later under the new circoviridae family (Tischer et al., 1982). Porcine circovirus type 1 (PCV1) is a readily-infectious but non-pathogenic virus. Porcine circovirus type 2 (PCV2) has pathogenic properties that lead to Postweaning Multisystemic Wasting Syndrome (PMWS) in swine.
Despite the differences in pathology between the Porcine circoviruses, PCV1 is of particular intrigue due to its potential of having anti-cancer properties. Although PCV2 also has VP3s, its nature of being lethal to cells makes it less useful when looking at anti-cancer properties (McKeown et al., 2005). This potential is seen evidently because of the presence of the third viral protein (VP3) within open reading frame 3 (ORF3) (Liu et al., 2006). Relatively little has been researched on this subject however. Once infected with PCV1, cancerous cells undergo apoptosis whereas primary cells are left unharmed. This property is shared with the Chicken Anemia Virus (CAV) VP3, also known as Apoptin.

CAV is a pathogen responsible for anemia through apoptosis of thymocytes and erythroblastoid cells in the bone marrow of chickens (Jeurissen et al., 1992). Apoptin exports to the cytoplasm in primary cells and localizes in the nucleus of transformed cancer cells. Apoptosis is triggered through a p53-independent pathway with G2/M mitotic phase arrest (Heilman et al., 2004, Heilman et al., 2006). In both cytoplasm and nucleus, Apoptin multimerizes into quaternary structures of 30-40 monomer units (Leliveld et al., 2003). Apoptosis pathways are activated upon Apoptin multimer binding to the APC1 subunit of Anaphase Promoting Complex/Cyclosome (APC/C), rendering it inactive and gathering as PML bodies in the nucleus (Heilman et al., 2004; Heilman et al., 2006). In contrast, PCV1 VP3 is not known to multimerize and will, in both primary and transformed cancer cells, always localize to the cytoplasm (Rogers et al., 2012). Despite the possibility of having selectivity in causing cancerous cells to undergo apoptosis, the exact mechanisms by which PCV1 VP3 causes apoptosis are still unknown. PCV1 VP3 is only indicated to have a caspase-dependent apoptotic pathway (Chaiyakul et al., 2010).

A similarity between PCV1 VP3 and apoptin is the fact that they both share the property of
being non-crystallizable. Apoptin, being small at only 121 amino acids and forming homomultimers of 30-40 proteins, cannot create consistent crystal lattice structures (Los et al., 2009). Although PCV1 VP3 does not multimerize and is larger than apoptin, it is still considered a small protein since it is only 206 amino acids (Chaiyakul et al., 2010; Heilman et al., 2004). This inability to crystallize renders the main procedure in determining the protein structure, x-ray diffraction, unfeasible. Nuclear magnetic resonance (NMR) imaging is a possibility for some small proteins (Acton et al., 2011), but such equipment was not available for this project. Along with this, NMR would raise some potential problems for this project. NMR can only work for short regions of proteins at a time which, in and of itself, takes a large amount of time to process. One problem with trying to use NMR to determine the structure of the NES regions is that the calculations that would need to be performed afterwards would be too complex and time-consuming (Marassi et al., 2000; Wang et al. 2000). The major problem is that this project was not looking specifically into discovering the structure of PCV1. Instead, the goal was to determine whether or not PCV1 VP3 binds to CRM-1. Despite this, the PCV1 VP3 gene has some intriguing properties that make it worth studying.

One of these properties is the fact that the PCV1 VP3 gene is almost twice the length of the PCV2 VP3 gene. Both PCV1 and PCV2 share a “core” region of the DNA with a similar homology of 80% (Hamel et al., 1998; Meehan et al., 1998; Morozov et al., 1998), however, the “tail” region on PCV1 is unique. In fact, the tail region adds a significant chain of amino acids onto the end of the protein. These additional amino acids contain evidence of a strong nuclear export sequence that may be key in elucidating the apoptotic pathway PCV1 VP3 uses in cancer cells (Clancey et al., 2013). Because of this, PCV1 has been seen to have an even greater apoptotic capability when compared to that of its sister virus of PCV2 (Chaiyakul et al., 2010).
The localization of PCV1 VP3 to the cytoplasm in both primary and cancerous cells rather than to the nucleus can be explained based on specific amino acid compositions within the VP3. There is a putative nuclear export sequence (NES) between residues 42-49, a putative nuclear localization sequence (NLS) between residues 80-105 (Rogers et al., 2012), and evidence of a strong NES located in the tail region of PCV1 VP3 between residues 134-149 (Clancey et al., 2013). Unlike PCV1 VP3, apoptin localizes to the nucleus in cancerous cells but to cytoplasm in primary cells (Heilman et al., 2004; Heilman et al., 2006). This localization is due to the two NLS regions found within the genome of apoptin (Heilman et al., 2004; Heilman et al., 2006). Since PCV1 VP3 exports to the cytoplasm, Clancey et al. designed 3 mutant constructs for PCV1 VP3. Each construct consisted of three mutations, of which three leucine residues were converted to alanine residues via site-directed mutagenesis. The three constructs created included one that had the first NES site mutated, one that had the second NES site mutated and one that had both NES sites mutated (Clancey et al., 2013). The results of the Clancey et al. study showed clearly that although the NES sites were mutated, the mutant constructs all localized into the cytoplasm. Since nuclear export was retained in the VP3 despite mutations of the NES sites, there may be a compensatory mechanism that was still allowing export, either the leucine to alanine mutations were not powerful enough or a different nuclear export sequence exists. Because of this, it was necessary to do further testing into whether or not the NES regions were solely responsible for export. The predicted NES in the tail region of PCV1 VP3 was believed to be responsible for the exportation of the VP3, in large part due to the fact that it was very similar to export sequences in other, known binders of CRM-1.

Another indication of this strong NES domain within the tail region of PCV1 VP3 includes a motif commonly found in export sequences that utilize the canonical CRM-1 transport protein. The
sequence within the tail region codes for amino acid sequence LHLVKSLLL (Clancey et al., 2013) which follows the pattern Φ-X2-3- Φ -X2-3- Φ -X- Φ, where Φ represents I, L, F, V, or M and X represents any other amino acid. The in-silico experiments done by Eisenberg et al. show with high confidence that the secondary and tertiary structure of the tail region of PCV1 VP3 exhibit domains characteristically used as a NES across the CRM-1 nuclear transport protein. An interesting feature of the NES domain is the secondary structure. PCV1 VP3 NES has been predicted to contain an alpha-helix domain, similar to many other NES domains (Eisenberg et al., 2013; la Cour et al., 2004).

Unlike PCV1 VP3 NES, Apoptin and snurportin-1, both of which are used as controls in this experiment, have little to no secondary structure other than having linear NES regions.

One way to test the CRM-1 dependence of a protein is to apply an inhibitor specific for the NES binding site in CRM-1. Leptomycin B is known to be a powerful CRM-1 competitive inhibitor. It does so by covalently binding and glycosylating the cysteine-528 residue located within the NES binding site. Using this nuclear export inhibitor with a GFP construct attached, it can be determined if PCV1 VP3 utilizes the CRM-1 pathway as the method of cytoplasmic localization. This would be compared to the nuclear export capabilities of Apoptin, which is known to export out of the nucleus via CRM-1 (Kudo et al., 1999; Petosa et al., 2004).

The goals for the leptomycin B inhibition is to show the effect of the CRM-1 NES binding site inhibitor, leptomycin B, on the transport of PCV1 VP3. Nuclear transport of a PCV1 VP3 construct only containing the tail region will be compared with the nuclear export of a whole PCV1 VP3 protein construct along with a mutant form of Apoptin that localizes to the cytoplasm. The results will determine whether the export of PCV1 VP3 from the nucleus is CRM-1 specific or if there is a secondary mechanism at work.
Since Apoptin and PCV1 VP3 cannot be crystallized, it cannot be determined whether these molecules bind to CRM-1 through co-crystallization. There was, however, another method that was designed to determine if these VP3s bind to CRM-1. Rapid prototyping, or three-dimensional printing, was used to test protein-protein interactions between predicted PCV1 VP3 structures and CRM-1. This is similar to the 3D physical model of lysozyme David Chilton Phillips created from x-ray crystallography data. This model of lysozyme could determine catalytic pockets, catalytic residues, and even demonstrate induced fit (Blake et al., 1965; Johnson et al., 1965). What this experiment sets to do is to use a novel form of modeling protein interactions through rapid prototyping to determine how well the NES sites of PCV1 VP3 and Apoptin fit into the CRM-1 NES binding site. Although programs exist that can simulate protein interactions such as protein-to-protein binding, the process of generating scripts to simulate cellular conditions can be daunting to researchers focused on in vivo or in vitro studies and have little to no experience with in silico procedures. The programs necessary for simulations can also be hardware intensive and not provide timely results on commonly found computers (Li, 2009). The application of three-dimensional printing to protein modeling provides an effective solution to expensive computers and confusing programs.

The advantage of the rapid prototyping of proteins allows for a better understanding of protein-to-protein interactions. The ability to hold an object in one’s hands and orient it to see all facets without obstruction can have a distinct advantage over attempting to do the same in a graphical viewer on a computer or through lines of code (Michael, 2001). A solid protein model can be seen much like a computer graphic, but a solid model can also provide resistance in the event of misfitting, indicating steric hinderance that can be easily identified. From an educational standpoint, three-dimensional printing of high-resolution protein structures has potential for teaching protein mechanics and systems
with a hands-on approach.

Learning is an interactive process in and of itself, resulting in the necessity of interaction between the learner and the material being studied. There are several methods of learning, however, including Kolb’s Learning Styles, Grasha-Reichmann Learning Styles and Felder-Silverman Learning Styles (Montgomery and Groat, 1998). These styles of learning each have their own specific focus. The most famous one however, is known as The VAK Framework (Tanner and Allen, 2004). This learning style has the name it does due to the three types of learners that make it up. Recently, however, this framework has had another style added to it, making it The VARK Framework (Tanner and Allen, 2004). The first of both of these are “Visual” learners. These learners use pictures and visual representations as their main source of information intake (Tanner and Allen, 2004). Similarly, “Kinesthetic” learners use visual representations, but do so using their sense of touch more so (Tanner and Allen, 2004). The other two types of learners, “Auditory” learners and “Reading/Writing” learners, use different styles of learning as well, but their styles are not related to the three dimensional prints that were made. The “Visual” and “Kinesthetic” learners, however, can use their vision and sense of feeling to learn material that might not have been as easily learnt otherwise. This is just one potential goal for the three dimensional prints.

Another goal for the 3D printing included having physical models of CRM-1 along with NES sites for PCV1 VP3, apoptin, and the NES site of a crystallized protein, such as snurportin-1. In order to have an effective solid 3D model of a protein with identifiable features, the final print must have an appreciable level of surface detail. The printed model should have structures and even residues that can be identified just by structural details and motifs, but since the printout is a replica of the in silico computer-generated models, the in silico models can be used as a reference. Most interior residues
will not be identifiable, but the functional R-groups of amino acids, if protruding enough, should be identifiable. Other less-noticeable surface amino acids can be supplemented by referencing a single file containing the tertiary structure of the protein.
Methods and Materials

Protein Prediction Analysis

Primary NES sequences for apoptin and PCV1 VP3 were submitted in FASTA format to I-TASSER through the Yang Zhang lab servers. PCV1 VP3 was submitted twice, once with the snurportin-1 NES (Protein Database entry 3NBZ, Guttler et al., 2010) sequence as a specific template without alignment and again with p53 NES (Protein Database entry 1AIE, Mittl et al., 1998) as a specific template with alignment. Apoptin was submitted once with snurportin-1 NES sequence as a specific template with alignment. The p53 NES site was selected from the NESdb website (Xu et al., 2012).

Three-Dimensional Printing

The open-source protein structure software PyMol from DeLano Scientific LLC., version 1.1eval, was used to view, edit, and convert space-filling models of CRM-1, apoptin predicted structures, PCV1 VP3 predicted structures, and snurportin-1 PDB (.pdb) files to VRML2 (.wrl) files. The open-source 3D-triangular mesh program MeshLab from Visual Computing Laboratory - ISTI - CNR, version 1.3.2_64bit, was used to convert the VRML2 files to Stereolithography (STL, .stl) format.

To further edit STL files, Autodesk Inventor 2014 was used with the Mesh Enabler software from Autodesk Labs. STL files were converted to Autodesk Part files (.ipt), then edited and converted back to STL format. Autodesk Inventor 2014 was also used to run preliminary tests of NES site fittings to the NES binding domain of CRM-1 using an Autodesk Assembly file (.iam). The full editing process from PDB file to printing is attached in the Appendix.

Protein models in STL format were submitted through WPI Rapid Prototype and printed using
the Objet260 Connex Rapid Prototype machine. CRM-1 models were printed with VeroClear material and PCV1 VP3, apoptin, and snurportin-1 models were printed with TangoBlackPlus material. The addition of glossy surface, shelling between 1/8-1/16 inches and filling the models with support material were performed wherever possible. Dimensions were specified beforehand and all parts were made scaled to CRM-1 model dimensions.

A full printout of the CRM-1 protein with snurportin-1-bound conformation was made first, followed by an isolated model of the CRM-1 NES binding site with snurportin-1 NES, edited from Protein Database entry 3NBZ (Guttler et al., 2010). Subsequent printings were made of the QUARK-predicted structure of apoptin NES and the I-TASSER-predicted structure of PCV1 VP3 NES (Eisenberg, et al., 2013). Protein Database entry 3NC1 (Guttler et al., 2010) was used to print a CRM-1 NES binding site in an open conformation with no bound NES sequences. PCV1 VP3 tail NES was fitted with snurportin-1 NES and p53 NES (PDB entry 1AIE, Mittl et al., 1998) as templates without alignment through I-TASSER. Apoptin was also fitted with snurportin-1 NES as a template via I-TASSER predictions.

Cell Culturing

Non-small human lung carcinoma cell line H1299 were maintained using Dulbecco’s Modified Eagle Medium (DMEM)/High Glucose, 10% fetal bovine serum, and PSF (100 units/mL Pen G sodium; 100 mg/mL streptomycin sulfate; 0.25 mg/mL amphotericin B). Cells were incubated at 37°C and 5% CO₂ humidity. Cells were maintained in T25 vacuum plasma-treated culture flasks and kept below 90% confluence through constant passage. Cells were passed by aspirating old media followed by a washing with 2 mL of 1x PBS. The cells were detached from the flask using 1 mL trypsin (0.05% 1X Solution, with 0.5 g Porcine Trypsin (1:250/L gamma irradiated) in HBSS with 0.2 g/L EDTA,
without Calcium or Magnesium). Trypsin was aspirated after roughly 10 to 20 seconds of tilting back and forth, after which 2-5 mL of fresh media was added and agitated lightly through pipetting up and down until cells were thoroughly resuspended. Between 0.25 and 1 mL of the suspension was transferred to a new T25 flask depending on the amount of media used to resuspend cells and the initial confluence. Media was added to the new T25 flask to a final volume of 5 mL. Cells were allowed to approach 90% confluence before passing again, approximately every three days.

**Cell Plating**

6-well plates were prepared by adding a square coverslip, washed in 100% ethanol, to each well. The coverslips were allowed to air dry until all ethanol evaporated. When a H1299 culture in a T25 flask was passed according to the cell culturing methodology, 3 mL of resuspended cells in media was added to a 15 mL conical tube containing 10 mL of fresh media to create an approximately 1/3 dilution. 2 mL of the diluted cells were added to each of the 6 wells and allowed to grow to between 40-75% confluence in an incubator at conditions described in Cell Culturing.

**Transfection**

The plated H1299 cells were transiently transfected with apoptin that contained a double-mutant NLS, PCV1 VP3, and PCV1 VP3 tail region (a.a. 105-206). All mutants were N-terminally tagged with GFP and contained a CMV promoter region. Transfections were performed when H1299 confluence in the 6-well plates reached between 40-75% confluence. Old media was aspirated, followed by washing with 1 mL 1x PBS and adding 1.6 mL of fresh media for each well. The following steps used Effectene Transfection Reagent Kit from Qiagen. Plasmid DNA was added by diluting 0.8 μg DNA constructs with EC buffer to a final volume of 200 μL. 6.4 μL of enhancer was added, briefly vortexed, and allowed to incubate at room temperature for 2-5 minutes. This was
followed by the addition of 20 μL of the Effectene reagent after which, the solution was gently mixed. The DNA construct and Effectene mixture was allowed to incubate at room temperature for 5-10 minutes to allow the formation of complexes. After incubation, 1.2 mL of fresh media was added to the DNA/Effectene complex mixture and was mixed slowly. Approximately 710 μL of the DNA/Effectene complex with media was added to each well and gently swirled to mix. Plates were placed back in the incubator at conditions described in Cell Culturing.

**Leptomycin B Experiments**

Leptomycin B (LMB) was obtained from Sigma-Aldrich at a concentration of 5.5 μg/mL, 7:3 methanol to water ratio and from Santa Cruz Biotech at 50 μg and diluted in 10 μl of 7:3 ethanol to water ratio as recommended by the manufacturer. LMB was stored at -70°C due to its labile nature. Twenty-four hours post DNA transfection, H1299 cells close to 100% confluence in 6-well plates had media aspirated. Control samples requiring no LMB were replaced with 2 mL of fresh media. LMB from both Sigma-Aldrich and Santa Cruz Biotech were diluted separately in fresh media to obtain working concentrations of 2.5, 10, 50, and 250 ng/ml for the Sigma-Aldrich LMB and 2.5 and 25 ng/ml for the Santa Cruz LMB. 1.5 mL of each were very quickly added to each well. Three hours post addition of LMB, cells were fixed according to the procedure outlined in Cell Fixing below.

**Cell Fixing and Mounting**

Cells were fixed by aspirating old media, followed by washing with 1 mL 1x PBS per well. 1 mL of 4% paraformaldehyde in 1x PBS was added to each well and agitated slowly for 15 minutes. The paraformaldehyde solution was aspirated and the wells were washed twice with 1 mL 1x PBS per well. 1-2 mL of 70% ethanol were added to each plate and stored at 4°C until mounting. The 6-well plates with ethanol can be stored indefinitely at that temperature.
The glass coverslip within the the 6-well plates that have been treated with paraformaldehyde were removed and any ethanol was allowed to air dry briefly. Approximately 30 μL of mounting media (50% glycerol; 100 mM Tris (pH 7.5); 2% DABCO, 10μg/mL DAPI) was added to the center of a clean microscope slide. Coverslips were placed cell-side down onto the mounting media droplet and pressed to remove excess media. The coverslips were sealed to the microscope slide and allowed to dry in a dark environment before storing in an opaque container at 4°C.

Confocal Microscopy

Fields of view containing cells expressing GFP representative of all of the expressing cells were taken using a Leica TCS SP5 with a conventional scan head, a 405 blue laser diode, an argon laser (covering lines 458, 476, 488, and 514), a 561 DPSS, a 633 HeNe laser, 4 PMTs, and a transmitted light channel. The system was based on an inverted Leica DMI 6000 CS microscope base.

Quantification of GFP Expression

The software ImageJ was used to calculate relative pixel intensities in confocal images. Confocal images in JPEG format were opened and the Plot Profile tool was used. The Plot Profile selection was made by selecting a line approximately 200 pixels long perpendicular to the nuclear envelope, with approximately 100 pixels on each side of the envelope in the nucleus and the cytoplasm.

Relative GFP quantification was done through ImageJ by selecting areas encompassing only the nucleus or the cytoplasm of three representative cells for apoptin, PCV1 VP3, and PCV1 VP3 tail for both with and without LMB. The mean green pixel intensity was recorded through the Histogram function under the Analyze menu. Ratios of green pixel intensity in the cytoplasm to the intensity in the nucleus were recorded and averaged with standard deviation.
Results

Three-Dimensional Printing

Three dimensional printing has not been used to investigate the binding between proteins before this study. This study looked to show that three dimensional printing could be used as a system for predicting interactions between substrate and active site for both known and unknown structures. Since the structure of PCV1 VP3 is not known, printing predicted structures of the protein, both fitted to known binding proteins and not, allows for a physical model that might show whether binding occurs naturally or not. In order to do this, printing several proteins was required. The first protein to be printed was a printout of the whole CRM-1 protein from PDB entry 3NBZ (Figure 1). The size of the protein is approximately two inches at the longest length and can fit in the palm of a hand. The model printed out had some surprising results in terms of surface resolution despite such a small size. The Ran-GTPase binding site (green arrow) and NES binding site (red arrow) are easily visible to the naked eye, and small protruding structures such as amino acid R-groups and secondary structures are not as identifiable due to the small size. This high level of surface resolution at a small scale showed that printing a zoomed-in version of the CRM-1 NES binding site and zoomed-in versions of the protein NES sites would provide printouts with a great level of detail.

After printing the CRM-1 NES binding site, it was necessary to print both proteins that were known to bind with it as well as the predicted protein structures. The printing of the computer-generated in silico models of the NES sites yielded high-quality physical models that are almost exact to the computer models, save for coloration and a slight shift of curvature to polygonal structures (Figure 2). The computer models, aligned in the same orientation as the physical model photographs, show the high degree of surface feature resolution as come to expect from the whole
CRM-1 printed model. The resolution has been conserved between the computer models and the physical models, as each physical model contains the same surface topology as the computer models. This allows for easy identification of residues along the surface of the physical models even without color-coding as shown in the PyMol computer models.

In order to study possible binding interactions between the high resolution CRM-1 and PCV1 VP3, it was first necessary to look at molecules that were known to bind to CRM-1. The first structure looked at was CRM-1-bound Snurportin-1 from the PDB entry 3NBZ as seen in Figure 2A. Snurportin-1 was selected as a control since it was known to bind to CRM-1 and has a known, crystallized structure. What is notable is that the five leucines on the bottom side of the models are the hydrophobic residues responsible for binding to the hydrophobic pocket of CRM-1. This is an important feature that should logically be repeated in other NES sites that utilize the CRM-1 NES binding site. From this, the QUARK-predicted apoptin NES structure from Eisenberg et al., seen in Figure 2B, which is known to bind to CRM-1 but whose structure is unknown, was looked at. The hydrophobic residues are aligned in a similar fashion to snurportin-1, except with a slight twist as isoleucine-40 faces outwards and leucines-44 and -46 face inwards. This twisting would have some effect on the binding into the CRM-1 NES binding pocket. Since the fit of the QUARK-predicted apoptin was not very good, apoptin was fitted with snurportin-1 NES as a template (Figure 2C) without residue alignment through I-TASSER. The same residues were highlighted as in Figure 2B to show the degree of structure change. Isoleucine-40 and -42 along with leucine-44 have a more linearized orientation than the QUARK-predicted structure, but leucine-46 turned almost 90 degrees from its original point in the QUARK prediction model. The structural changes that occurred in this predicted model are in stark contrast to the model shown in Figure 2B, therefore the binding and steric hindrance
would change dramatically in comparison to the original QUARK predicted Apoptin model. What is interesting to note is the models in Figure 2A and 2C adopt a very similar shape, possibly hinting that the I-TASSER snurportin-1-fitted Apoptin may fit in the CRM-1 NES binding site better.

With two proteins, both known to bind to CRM-1 but one with an unknown structure, it was possible to print out predicted PCV1 VP3 tail NES sites with which other structure could be compared. Figure 2D shows the PCV1 VP3 NES as predicted through I-TASSER in Eisenberg et al. Unlike panels A-C, the protein is more globular in shape due to the predicted alpha-helical shape. Numerous NES sites are alpha-helical, but doubts were raised at the ability of the printed I-TASSER PCV1 VP3 tail NES to be able to fit into a printed CRM-1 NES binding site due to the bulbous nature. The highlighted residues, particularly the hydrophobic ones, have a more scattered orientation rather than remaining aligned. This bulbous shape and pattern are reflected in Figure 2E, with PCV1 VP3 NES fitted without alignment to snurportin-1 NES. The result was still an alpha-helix, but with a slight reorientation of the residues. Leucine-8 and -15 are behind the model and could not be highlighted.

Figure 2F is with PCV1 VP3 NES fitted without alignment to p53 NES from PDB entry 1AIE, and again shows a globular, alpha-helix assembly. The residues in panel F shifted the greatest in comparison to the shifts in residues in panel E from the original I-TASSER prediction. These thick structures were puzzling not only in their ability to fit, but the seemingly random orientation of the hydrophobic residues among charged residues raised doubts of the stabilization of these predicted NES sites into the CRM-1 binding site.

The next logical step was to print out the CRM-1 NES binding site to see if the printed NES structures sterically fit into the site. CRM-1 with snurportin-1 bound was chosen as a closed conformation model, since only snurportin-1 should fit perfectly within the binding site, and an open
conformation of CRM-1 was chosen since all NES sites should fit in loosely. In both the closed (PDB 3NBZ) and open (PDB 3NC1) conformations, residues 500-600 were selected and further edited in Autodesk Inventor 2014 to yield the final models shown in Figure 3. Figure 3A is a view of the CRM-1 closed conformation and Figure 3B is a view of the open conformation. Due to limitations in the ability to accurately manipulate the orientations of the computer models, the cutouts differ slightly in size and which residues contained. However, the binding pocket in both are whole and intact, and without reference to the \textit{in silico} graphic models, some structures can be seen to be conserved between the two conformations.

As required to allow for the least amount of error in fitting, the models of CRM-1 and the NES sites were all printed to the same scale. Since the surface features of the NES models are easily identifiable in Figure 2, it would only be natural for surface details in the CRM-1 models be identifiable. Figure 4 is the comparison of closeups of the binding sites in PyMol with specific residues highlighted to the printed physical models. Figure 4A is the closed CRM-1 conformation and Figure 4B is the open conformation. Features such as leucine-522 in panel A and the glutamic acid-529 in both panels are easily identifiable protrusions in their respective models. However some residues, such as cysteine-528, an important residue for NES binding, is barely recognizable within the model and could not be identified without using the computer model as a reference. The ability to identify specific residues will be important for determining steric hindrance, or the lack thereof, on a molecular and atomic scale between the printed models of the CRM-1 NES binding sites and the NES models.

The effectiveness of the CRM-1 printed models was tested by placing the printed snurportin-1 NES site from PDB file 3NBZ into the CRM-1 NES binding pocket. Figure 5 shows the fit of snurportin-1 into the closed (panel A) and open (panel B) CRM-1 NES binding pockets. The ridge of
hydrophobic amino acids as shown in Figure 2A was a snug fit into the closed binding site with a slightly looser fit in the open conformation. With the model known to bind to CRM-1 and with a known structure fitting well, it further showed the reliability of the models to properly replicate induced fit and steric hindrance.

The next step was to fit the printed QUARK prediction of Apoptin in the open and closed conformations of CRM-1. The fitting showed a significant amount of steric hinderance, as shown in Figure 6. Panels A and C show the open CRM-1 conformation while panels B and D show the closed conformation. Panels C and D are closeups of the large gaps noticeable between the Apoptin NES and the CRM-1 NES binding pocket. The large gaps are indicative of improbable hydrophobic residue interactions between the NES site and the binding pocket. It is clear that steric hindrance is preventing the NES site from entering fully.

When Apoptin was fitted with snurportin-1 as a template and the corresponding prediction printed, it appeared to have a greater fit than the QUARK apoptin predicted structure. Figure 7 shows this predicted print when placed into the CRM-1 NES binding site. Significant structural details can be seen to fit into depressions along the binding site in panel A of the open conformation and panel B of the closed conformation. The gaps shown in panels C and D are smaller than that of Figure 6C and 6D. The fit was surprisingly snug into the open CRM-1 conformation in comparison to the loose nature of the QUARK predicted Apoptin structure fit. This supports that using the snurportin-1 NES as a template provided a possible Apoptin NES structure capable of fitting into the CRM-1 NES binding site.

Having fitted all of the known three dimensional prints of binding proteins to CRM-1, the next step taken was to test the predicted structures of PCV1 VP3. Since this VP3 was only predicted to
bind to CRM-1, there was the possibility that the 3D print would not fit into the binding pocket well. Figures 8-10 show different iterations of PCV1 VP3 tail NES predicted structures and their fit into CRM-1. Figure 8 is the original predicted structure from Eisenberg et al., Figure 9 is PCV1 VP3 tail NES fitted to snurportin-1 NES, and Figure 10 is PCV1 VP3 tail NES fitted to p53 NES, another known CRM-1 binding-NES site with a known structure. The figures show the best steric fit found with the models are not realistic. Numerous gaps are shown in panels C-D shown in Figures 8-10, pointing to a large amount of steric hinderance. The positions of some of the NES sites contain charged groups facing into the hydrophobic CRM-1 NES binding pocket, which is energetically unfavorable and very unlikely to occur in a stable manner. All three structures should be possible given allowable bond angles, but the globular nature of the alpha helices are sterically preventing entry into the open CRM-1 NES binding site. This may suggest that the CRM-1 NES binding site isn’t in a fully open conformation, the PCV1 VP3 tail NES sites undergo their own conformational change, or that these predicted PCV1 VP3 models are not the correct structures.

**Leptomycin B Experiments**

Fitting apoptin to snurportin-1 showed a clear increase in fitting for apoptin to the CRM-1 NES binding site, but did not show much, if any, increase in fitting for the PCV1 VP3 tail NES to the CRM-1 NES binding site. Since the binding did not fit very well, this supported the conclusion that Clancey et al. had made, that there is another factor allowing nuclear export besides CRM-1. To find more evidence of PCV1 VP3 interaction with CRM-1, in vivo studies utilizing leptomycin B were performed. These experiments in conjunction with the 3D printed models will provide a basis of determining whether PCV1 VP3 actually interacts with the CRM-1 NES binding site. Leptomycin B is a powerful
CRM-1 inhibitor, so if PCV1 VP3 utilizes the canonical CRM-1 nuclear export pathway, then there should be clear inhibition of the VP3 export when visualized with a fluorescent reporter such as GFP. The aim of this experiment is to further investigate CRM-1 dependence of PCV1 VP3 that the results of Clancey et al. may have missed. Their results suggest that the putative PCV1 VP3 tail NES site was not important for nuclear export since mutagenesis of the NES did not prevent cytoplasmic localization. Leptomycin B, a competitive CRM-1 NES binding site inhibitor, will further demonstrate the CRM-1 reliance or non-reliance of PCV1 VP3 tail NES.

Cells transfected with double-NLS-mutation Apoptin, PCV1 VP3, and the tail section of PCV1 VP3 with GFP tags without leptomycin B are shown in the confocal images in Figure 11. The ΔΔNLS mutant of GFP was used as a control to show controlled cytoplasmic localization. All three constructs show strong cytoplasmic localization of GFP, indicative of active nuclear export. These results were expected, for all three constructs contained or are predicted to have nuclear export sequences, causing cytoplasmic localization.

Next was using leptomycin B to inhibit CRM-1-mediated nuclear export. The confocal microscopy in Figure 12 shows the effects of leptomycin B inhibition on the localization of the VP3 constructs. Cytoplasmic expression of GFP is still relatively strong, however there is a significant increase of nuclear GFP expression for Apoptin ΔΔNLS and PCV1 VP3 WT. This shows that the leptomycin B is inhibiting CRM-1, and that PCV1 VP3 WT is affected by inhibition of the nuclear export protein. Surprisingly, tail-only PCV1 VP3 showed little to no nuclear localization and is almost indistinguishable from a non-leptomycin B-treated cell.

To accurately determine the amount of VP3 export from the nucleus into the cytoplasm, quantification of GFP expression by measuring green pixel intensity was performed (Figure 13). The
red line denotes the approximate region of the nuclear envelope, with the left side of the red line being cytoplasmic and the right side nuclear. As visually recognizable from Figure 12, Apoptin ΔΔNLS and PCV1 VP3 WT nuclear GFP expression dramatically increases when leptomycin B is present. There is a small increase in nuclear GFP expression for PCV1 VP3 tail in the presence of LMB, but it is not an increase in expression comparable to Apoptin ΔΔNLS or PCV1 VP3 WT. To test the likelihood of these results, the averages of ratios of cytoplasmic GFP expression to nuclear expression of representative cells through confocal imaging are shown in Figure 14. A two-sample T-test performed with a null hypothesis of leptomycin B inhibits CRM-1/NES site binding and preventing VP3 export into the cytoplasm was performed. Apoptin ΔΔNLS and PCV1 VP3 WT failed to reject the null hypothesis with 95% confidence. PCV1 VP3 tail calculated a p-value of 0.20, rejecting the null hypothesis and suggesting a possible secondary explanation.
Discussion

The results discovered from the 3D printing and leptomycin B experiments are found to be consistent with the results of the mutagenesis experiments from Clancey et al. The leptomycin B experiments support the idea of a compensatory mechanism or secondary nuclear export pathway that is allowing the PCV1 VP3 tail to localize to the nucleus despite CRM-1 inhibition, and the 3D prints do not show a conclusive binding affinity for the predicted PCV1 VP3 tail NES structures. The 3D printed predicted PCV1 VP3 tail NES sites showed large amounts of steric interference when attempted to fit into the CRM-1 NES binding site models. The leptomycin B experiments indicated that the tail region of PCV1 VP3 still localized to the cytoplasm despite CRM-1 export inhibition, but the whole PCV1 VP3 protein was strongly affected by the inhibition. It is possible that PCV1 VP3 utilizes the CRM-1 export pathway, but it is also possible that there is a secondary pathway used in conjunction with CRM-1 or to compensate for CRM-1 inhibition.

Despite not having a clear answer to how PCV1 VP3 tail NES may bind to CRM-1, the printed models were a success in demonstrating induced fit, conformational change, and an ease of defining surface features. The resolution achieved in the printed models of the NES sites and CRM-1 binding domain was more than enough to point out protruding amino acid R-groups along the surface. This level of detail could be enough to find steric collisions and possible interactions within not only CRM-1 and NES site interactions, but other receptor-ligand or enzyme-substrate interactions to further understand the mechanisms behind signaling, catalysis, and conformational changes. A noticeable problem is that at larger scales, surface resolution begins to deteriorate. Preliminary, small-scale printings such as Figure 1 had smooth, continuous surfaces. Upon scaling up the physical models shown in Figures 2-4, smooth surfaces started to give way to multi-polygon faces.
An explanation for the polygon facets may be due to the file types used. The conversion of Protein Database (.pdb) files to Virtual Reality Modeling Language (VRML) through PyMol may be using a point- or polygon-based vector graphics coding. This takes surfaces and renders them as a series of geometric shapes, such as polygons. The smaller the polygons, the greater the resolution of the surface being generated, but at increasing computer hardware intensity. At no point through the design of the models was there a noticeable way to increase or decrease the surface resolution, leading to the noticeable polygonal patterns along the NES printouts. These non-smoothened surfaces may have an impact on the way the models fit together, creating constraints or removing existing ones due to very slight shape changes.

A problem that arose while making the models was the lack of coloring options. Having a protein printed in multiple colors could allow for specific sequence highlighting, atom coloration, or surface charge maps showing gradients of positive, negative, and neutral charges along the surface of the protein. The printer only supported up to two colors at any one time, and although the colors could be changed out, it would incur a fee and a need to purge the machine of the previous colored material. A possible workaround would be to manually color the final printed structures, but this would be far less accurate than printing the colors out with the model. If the printed models from this experiment were colored, it would make distinguishing specific parts of residues easier, such as allowing the cysteine-528 in the physical models in Figure 2 to be easily identifiable through the coloration of the sulfur atom. By making specific residues stand out, it would be easier to determine steric hindrance and charge attraction and repulsion on a molecular and atomic scale through the models alone.

The results of the printing were promising despite the non-binding of the PCV1 VP3 tail NES structures. The original predicted models from Eisenberg et al. of Apoptin and PCV1 VP3 did not fit
the CRM-1 NES binding site models. Using the snurportin-1 NES as a template to predict the structure of the Apoptin NES yielded a much better fitting printing model. The same could not be replicated in PCV1 VP3 tail NES, were using snurportin-1 NES and p53 NES did not give sterically-fitting structures. Investigating the positions of residues along the models in silico for the PCV1 VP3 models would show that few if any of the hydrophobic amino acids aligned in a way to interact with CRM-1 in a similar way to snurportin-1. Despite the lack of success in finding a fitting structure for PCV1 VP3 tail NES, the printed models were able to provide a suitable medium for determining steric hindrance among identifiable amino acids. The lack of finding a PCV1 VP3 structure that could fit into the CRM-1 NES binding site may be circumstantial evidence in showing a possible secondary mechanism for nuclear export, in that the structures found could be the actual structures, but do not bind to CRM-1 in the present conformation or utilize a different mechanism for nuclear export.

The LMB experiments yielded results that were conclusive with the results from Clancey et al. PCV1 VP3 tail section of the protein did not respond to LMB inhibition of CRM-1 in the same way as Apoptin and the full PCV1 VP3 protein. If the predicted NES site in the tail uses CRM-1, then there should have been a large degree of nuclear localization. Instead, as shown in Figure 12 and graphically in Figure 13, there was only a small degree of nuclear localization of the GFP-tail construct. The results of the two-sample T-test for the average cytoplasmic/nuclear GFP expression ratio indicated that the similar ratios were statistically significant and that there was another explanation for the localization.

There is the possibility of a secondary system or compensatory mechanism that is allowing PCV1 VP3 tail to localize to the cytoplasm. One such possibility is that the putative NES site and the strong predicted NES site in PCV1 VP3 both contribute to nuclear exportation. The putative NES site between residues 42-49 could be the principal sequence that binds to the CRM-1 NES binding site,
with the stronger predicted NES binding elsewhere on CRM-1 or another transporter. When the
CRM-1 NES binding site is blocked by LMB, the equilibrium CRM-1 and PCV1 VP3 binding shifts
towards non-binding, leading to lowered exportation of PCV1 VP3 than when CRM-1 is uninhibited.
If one binding site on PCV1 VP3 cannot attach to CRM-1, then the other might not be enough to
compensate for the whole protein. If only the tail NES is present, as in this experiment, LMB inhibition
did not affect this secondary site, and transport would still occur.

Another possibility is that the core region of the PCV1 VP3 protein, while still attached to the
tail region, only exposes the N-terminal putative NES site. This NES domain, weaker than the NES in
the tail, would be more affected by LMB inhibition of CRM-1. Removal of the core region exposes the
tail NES, allowing it to bind to CRM-1 despite LMB inhibition. The exposure of the tail NES would be
due to protein misfolding. Some structures generated by Eisenberg et al. are counterintuitive to this
idea. PCV1 VP3 has been predicted to have two major regions - the tail and the core - that fold
relatively independent of each other and removal of one region or the other may not have an effect on
the secondary and tertiary structures of the other.

In summary, the results of the leptomycin B inhibition experiments and the lack of success in
determining a structure for PCV1 VP3 tail NES qualify the data obtained from Clancey et al.
mutagenesis experiments. A secondary mechanism is believed to exist that allows PCV1 VP3 to
localize to the nucleus that does not utilize the canonical CRM-1 export pathway. It should be noted
that three-dimensional printing of proteins is not always a fast alternative to traditional computer
modelling. Instead, it is a supplement in the investigation of tertiary structure in structure-function
relationships where traditional methods, such as protein crystallography, are a non-option. Even protein
structures found through traditional methods can still be supplemented with physical models, especially
As teaching tools, these models represent several biochemical themes with great success. Not only do the models have great resolution, but some key concepts such as induced fit are easily seen. When comparing the fit of different molecules as seen in Figures 2-10, it is hard to see induced fit by photograph alone. If the models are placed in by hand, it is quite easy to see the effects that conformational changes within a protein can have on binding. There is a certain amount of “wiggle” room that is felt when changing the model that is placed in both the open and closed conformations of CRM-1. This “wiggle” room can be useful for seeing how open and closed conformations affect binding proteins. Kinesthetic learners, or learners who use feeling or touching as their main source of information intake, can clearly feel the difference between open and closed conformations of CRM-1 or any protein. Because of this, fitting the different molecules seen in Figure 2 into the CRM-1 NES binding pocket has a clear difference in “wiggle”. This difference allow kinesthetic learners to understand concepts such as induced fit in a way that is easiest for them to learn. These 3D prints also allow both visual and kinesthetic learners to learn about amino acids and what residues look like within or around the binding pocket. Unfortunately, auditory and reading/writing learners do not gain many benefits from these three dimensional prints. Overall, using these 3D prints as a way to teach biochemistry to students may prove effective for specific topics. In the future, printing three dimensional prints of proteins may be useful, assuming the right polymer can be found, for showing interactions between amino acids.

There were some experiments that, due to a combination of a lack of time and a lack of funding, were not able to be studied at this time. One of these studies, the competition of small polypeptide fragments with PCV1 VP3, would be useful as an experiment due to the what would be studied. Since
PCV1 VP3 was still exported into the cytoplasm, even when LMB was added, it might be useful to see whether or not the CRM-1 molecule is solely responsible for VP3 exportation. The major problem that arose for this project was the fact that in order to have these constructs manufactured by a company, it cost much more than what was allocated for funding at the time. A possible solution to this was that the construct would be created within the lab, using a red fluorescent molecule that could contrast with the green GFP. This would both reduce the cost and allow for microscopy to be somewhat simple. This would, however, only be one potential experiment. Something that was attempted but was not successful was a mutagenesis experiment. This experiment would look at the “tail” region of PCV1 VP3 and would cut it in half. The second NES region was predicted to be responsible for the export seen by the VP3. This experiment would place the NES in the first and third of the three constructs. The first construct would be the first half of the “tail”, including the NES. The second construct would be the second half of the VP3 and the third construct would have the full “tail” region as a control for the experiment. These constructs would be placed within a GFP vector and would be transfected as was done within this experiment. Both of these experiments might help to elucidate the way PCV1 VP3 binds to CRM-1. The three dimensional printing showed promise for looking at interactions between active site and substrate, but there were a few properties of the 3D printing that could be improved on. If there was a polymer or some sort of printing material that could be printed in the models that allowed for a certain level of flexibility to occur in specific areas, this could benefit the prints. One way this would benefit them would be by being able to change the active site from an open to a closed conformation without having to print several copies. There is no material, to our knowledge, that has been developed to do this for three dimensional printing. In order for this to work, there would need to be a high level of understanding of both induced fit and conformational shift. Since the pathway for
PCV1 VP3 is not completely understood, there is the possibility that three dimensional printing could still be useful. There is the potential, as seen by the LMB tests, that there is something else responsible for the export of the VP3 from the nucleus. If this is the case, further experimentation would be necessary to shed light on what is truly behind the export of PCV1 VP3.
Figure 1 - Whole CRM-1 Protein Printout The green arrow denotes the Ran-GTPase binding pocket and the red arrow denotes the NES binding pocket. The surface detail of the relatively small, handheld model is enough to identify certain features such as the binding pockets, but it is difficult to identify smaller features such as R-groups and secondary structure without reference.
Figure 2 - PyMol Computer Models and Final 3D Printed Physical Models of NES Sites

(A) Crystallized snurportin-1 NES. Hydrophobic residues line the lower part of the NES site, with charged residues such as arginine-11 and proline-3 along the fringes. (B) Apoptin QUARK predicted NES model. Hydrophobics are along the lower part of the molecule, but twist away. (C) Apoptin NES fitted to snurportin-1 NES without alignment. The hydrophobic residues are more linear, with the exception of leucine-46. (D) PCV1 VP3 I-TASSER predicted NES. Hydrophobic leucines and isoleucines are distributed throughout the alpha-helix structure. (E) PCV1 VP3 NES fitted with snurportin-1 NES without alignment. A slight shift in amino acids is observed from the I-TASSER model, but still retains the alpha-helix. (F) PCV1 VP3 fitted with p53 NES without alignment. This model adopted a different, yet still alpha-helical structure than either the original I-TASSER or snurportin-fitted models. The hydrophobics are still scattered with no clear pattern. All models A-F have features easily identifiable from the PyMol graphical representations.
Figure 3 - Printed CRM-1 NES Binding Site Models (A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. Both were residues 500-600 isolated and edited to give the smoothened sides to ease printing.
Figure 4 - PyMol Computer Models and CRM-1 NES Binding Site Model Details (A) Closed Conformation. (B) Open conformation. Specific residues such as glutamic acid-529 are easily identifiable on the model. Some residues that are deeper in the binding pocket or deeper in the protein overall, such as cysteine-528, are not easily identifiable in a single-color model without guidance from the computer model.
Figure 5 - Snurportin-1 NES and CRM-1 NES Binding Site Fit  (A) CRM-1 NES binding site in the closed conformation state.  (B) CRM-1 NES binding site in the open conformation state.
Figure 6 - QUARK Apoptin NES and CRM-1 NES Binding Site Fit

(A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. (C) Closeup of gaps between Apoptin and CRM-1 closed conformation. (D) Closeup of gaps between Apoptin and CRM-1 open conformation.
Figure 7 - SNP1-Fitted Apoptin NES and CRM-1 NES Binding Site Fit (A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. (C) Closeup of gaps between Apoptin and CRM-1 closed conformation. (D) Closeup of gaps between Apoptin and CRM-1 open conformation.
Figure 8 - I-TASSER PCV1 VP3 Tail NES and CRM-1 NES Binding Site Fit (A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. (C) Closeup of gaps between PCV1 VP3 and CRM-1 closed conformation. (D) Closeup of gaps between PCV1 VP3 and CRM-1 open conformation.
Figure 9 - I-TASSER PCV1 VP3 Tail NES and CRM-1 NES Binding Site Fit (A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. (C) Closeup of gaps between PCV1 VP3 and CRM-1 closed conformation. (D) Closeup of gaps between PCV1 VP3 and CRM-1 open conformation.
Figure 10 - I-TASSER PCV1 VP3 Tail NES and CRM-1 NES Binding Site Fit (A) CRM-1 NES binding site in the closed conformation state. (B) CRM-1 NES binding site in the open conformation state. (C) Closeup of gaps between PCV1 VP3 and CRM-1 closed conformation. (D) Closeup of gaps between PCV1 VP3 and CRM-1 open conformation.
Figure 11 - Confocal Microscopy of VP3 Transfected Cells without Leptomycin B  The confocal microscopy shows DAPI staining of nuclear material, GFP expression, and merged images. Clear cytoplasmic localization is present for all three VP3 constructs.
Figure 12 - Confocal Microscopy of VP3 Transfected Cells without Leptomycin B  Significant nuclear localization of GFP is present within the cells for Apoptin ΔΔNLS and PCV1 VP3 WT. PCV1 VP3 tail does not exhibit the same nuclear localization, instead having similar cytoplasmic GFP localization to the control.
Figure 13 - Graphical Comparison Between Cytoplasmic and Nuclear GFP Expression

Left of the red line in each graph is cytoplasmic expression, and right of the red line is nuclear expression, measured by pixel intensity of the confocal images. Controls of Apoptin ΔΔNLS have much greater cytoplasmic GFP expression than nuclear. Apoptin ΔΔNLS and PCV1 VP3 after LMB treatment have noticeably increased nuclear GFP expression. PCV1 VP3 Tail only shows a minor increase in nuclear GFP expression when treated with LMB.
Figure 14 - Figure 4 - Cytoplasmic Expression of GFP Relative to Nuclear GFP Expression

Ratios were taken of GFP expression in the cytoplasm to the nucleus in Apoptin ΔΔNLS, PCV1 VP3 WT, and PCV1 VP3 Tail-expressing cells. The averages of the ratios of non-LMB and LMB treated cells are plotted above. In both Apoptin ΔΔNLS and PCV1 VP3 WT, the ratio of cytoplasmic to nuclear GFP expression decreased. PCV1 VP3 WT treated with LMB resulted in cases where GFP expression was higher in the nucleus than in the cytosol. PCV1 VP3 Tail only had a slightly lowered cytoplasmic-to-nuclear GFP expression average ratio, with the possibility of an overlap at one standard deviation. This may suggest that LMB had only a minor effect on the nuclear export of PCV1 VP3 Tail.
References


17 (6): 527-736


http://globocan.iarc.fr/Pages/fact_sheets_cancer.aspx

Appendix

Necessary Programs

<table>
<thead>
<tr>
<th>Name</th>
<th>Version</th>
<th>Company</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>PyMol</td>
<td>1.1eval</td>
<td>DeLano Scientific, LLC.</td>
<td><a href="http://download.cnet.com/PyMOL/3000-2054_4-10914845.html">http://download.cnet.com/PyMOL/3000-2054_4-10914845.html</a></td>
</tr>
<tr>
<td>MeshLab</td>
<td>1.3.2</td>
<td>Visual Computing Laboratory - ISTI - CNR</td>
<td><a href="http://meshlab.sourceforge.net/">http://meshlab.sourceforge.net/</a></td>
</tr>
<tr>
<td>Autodesk Inventor 2014</td>
<td>Build 170</td>
<td>Autodesk, Inc.</td>
<td>Obtained through WPI servers</td>
</tr>
<tr>
<td>Leica Application Suite Advanced Fluorescence Lite</td>
<td>2.6.0 Build 7266</td>
<td>Leica Microsystems</td>
<td>Obtained through Victoria Huntress (Gateway Park, WPI)</td>
</tr>
</tbody>
</table>

Other Useful Programs

<table>
<thead>
<tr>
<th>Name</th>
<th>Version</th>
<th>Company</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwissProt DeepView*</td>
<td>4.1</td>
<td>Swiss Institute of Bioinformatics</td>
<td><a href="http://spdbv.vital-it.ch/">http://spdbv.vital-it.ch/</a></td>
</tr>
<tr>
<td>UCSF Chimera**</td>
<td>1.3.2</td>
<td>Regents of the University of California</td>
<td><a href="http://www.cgl.ucsf.edu/chimera/">http://www.cgl.ucsf.edu/chimera/</a></td>
</tr>
</tbody>
</table>

*PDB file viewer only. Easier to use over PyMol, it is recommended for first-time users to use SwissProt Deepview to edit proteins if uncomfortable or confused by inputting command lines, then use PyMol to convert to VRML2 file.

**PDB file viewer with ability to convert to STL file format directly. User-friendly, however this program was not extensively used in this project. STL file quality is undetermined.
Model Preparation Protocol

1) Converting .pdb files with known structure, predicted structure, and/or hypothesized structure to .stl for printing or for further editing.

1.1) Have .pdb files ready by downloading from RSCB Protein Data Bank for known proteins, creating proteins through protein prediction software, or make constructs manually through PyMol or similar programs.

1.2) Open .pdb file in PyMol.

1.3.1) Click File > Open…

1.3.2) Alternatively, type “open [file directory]” in the command line with the directory to the .pdb file. Remove the brackets and quotations.

1.4) Edit protein to your discretion if not done so previously.

1.4.1) Parts of the protein can be edited.

1.4.1.1) Type “sele [selection name], resi #” in the command line to select specific residues. The # can be an amino acid residue number (e.g. 4) or range of residue numbers (e.g. 5-27). Naming the selection is optional, do not include the brackets. If not naming, do not include the comma.

1.4.1.2) Type “sele [selection name], (resn [1], [2], [3]...)” to select specific residues with their three-letter name code. Remove the brackets and numbers (e.g. sele (resn gly, arg, pro)). Naming the selection is optional, do not include brackets. If not naming, do not include the comma.

1.4.1.3) Alternatively, hold Ctrl and click on residues to select. What is selected can be changed by clicking “Selecting” in the bottom-right of the viewing window or by clicking Mouse > Selection Mode in the menus in the command window.

1.4.1.4) To select everything in the viewing window, type “sele all” in the command line.

1.4.1.5) Type “remove sele” after selecting residues, or “remove [selection name]” in the command line if selecting a previously named selection. Remove the brackets if removing a named selection.

1.4.2) Color the protein as desired. The color will transfer over to .stl files.
1.4.2.1) Select portions as demonstrated in step 1.4.1 to be colored.

1.4.2.2) Type “color [color name], sele” to color currently selected portions or “color [color name], [selection name]” to color previously named selections. Remove brackets for the color name (e.g. red, blue, green, etc.) and selection name.

1.4.3) Verify the 3D printer can print different colors. If not, the file will only be printed according to the colors the printer supports.

1.5) Click File > Save Image As > VRML 2… and save the file as a .wrl file. Add the extension .wrl to the end of the file name (ex., instead of naming the file “protein”, name it “protein.wrl”).

2) Converting the .wrl file to the file format required for printing.

2.1) Open Meshlab, click File > Import Mesh… and open the .wrl file previously made.

2.2) Click File > Export Mesh As…

2.3) Click the drop down menu “Files of type:” at the bottom of the window and select “STL File Format (*.stl)” and save the file as the .stl format.

2.4) Proceed to printing if no further editing is desired.

3) Converting .stl file to .ipt for further material removal and editing.

3.1) Open Autodesk Inventor 2014 and click File > Open or select the Open option from the Welcome window.

3.1.1) Click the “Files of type” drop down menu in the Open window and select the “STL Files (*.stl; *.stla; *.stlb)” option.

3.1.2) Select and open the .stl file exported previously from MeshLab.

3.2) Convert the .stl file to an editable entity.

3.2.1) Open the user interface window if not opened already by clicking View > User Interface on the toolbar. The User Interface will be on the left side of the window and will have “Model” in a gray bar on the top.
3.2.2) Right click on the surface representation of your model in the User Interface toolbar window on the left. This should be directly under the folder icon named Origin and will have the same name as the .stl file.

3.2.3) Click Convert to Base Feature. A small window will open. Click the Solid/Surface button. This button has a yellow cube icon.

3.2.4) Keep the “Delete Original” option checked, then click OK. The conversion may take a few minutes depending on the level of detail in the model.

4) Cutting and extruding additional features to the model.

4.1) Create a new sketch on a work plane with a profile to be cut out.

4.1.1) Click the 3D Model tab. To add features to a surface present on the model, click “Create 2D Sketch” and proceed to step 4.2. If not, create a work plane.

4.1.1.1) In the User Interface toolbar on the left, Click on the plus button to expand the Origin folder.

4.1.1.2) Click on a plane (YZ, XZ, or XY) that corresponds to the direction cutting is desired.

4.1.1.3) Click and drag a yellow corner of the selected plane to offset.

4.1.1.4) Drag the plane or type in a desired offset distance then click the green check mark.

4.1.1.5) Right click on the newly created work plane and select New Sketch, or click “Create 2D Sketch” under the 3D Model tab and click the work plane.

4.2) Add in shapes to add to or cut from the model as desired. The shapes are found under the Sketch tab, which appears after starting a new sketch.

4.2.1) Click Project Geometry under the Sketch tab to add in references points and lines corresponding to shapes in the model.

4.4) Click the 3D model tab then click Extrude.

4.5) Click on the Extrude or Cut option and drag the arrow, type in a distance, or if extruding to a surface, select To in the dropdown menu under Extents.
4.6) Repeat with new sketches and extrusion/cuts until model is edited as desired.

5) Checking fit of two .ipt models in an assembly (.iam) file.

5.1) Open an assembly file with parts to be tested.

5.2) Click New and select Standard.iam under Assembly-Assemble 2D and 3D components

5.3) Click Place under the Assemble tab.

5.4) Select one of the .ipt files to be tested and place it anywhere in the viewing window.

5.5) Repeat until all desired parts are placed in the viewing window.

5.6) Click Free Move and Free Rotate to move the parts into a desired fit and orientation.

5.6.1) Right click on the part name in the user interface window.

5.6.2) Click the Grounded option to prevent the part from being moved.

5.7) Click the Inspect tab and click Analyse Interference.

5.8) Select two objects and click OK.

5.9) Move the objects and repeat analysis.

6) Convert .ipt file back to .stl format for printing.

6.1) Open the .ipt file of the desired object.

6.2) Click Save As > Save Copy As…, then click the “Save as type” drop down menu and select STL Files (*.stl)

6.4) Click Options in the bottom of the window.

6.5) Change the units to inches or centimeters, this will help with scaling later. Set Resolution to the High option and have Export Colors checked off.

6.6) Save the file as .stl extension and proceed with printing.